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Introduction
I like to listen to music when I program, so when I bought my CD-ROM 

drive, I not only intended to use it for data purposes but also for audio.    Prior
to my CD-ROM drive, I was running the output from my portable audio CD 
player through my sound board.    While this worked fine, it was a pain always
connecting and disconnecting it when I wanted to take it somewhere.

So when I bought my CD-ROM drive, I first used the audio CD program 
that came with my sound card.    It was pretty basic and did the job, but it 
wasn't Windows based, it misbehaved under Windows, and just wasn't what I
wanted.    So I looked through the CD-ROM forum on Compuserve, and while I
liked some of the programs, some would terminate unexpectedly others had 
more features than I wanted.    As a result, a programmer by profession, I 
decided to write my own.

CDMaster is the result of that effort.    It was written in 'C' using Borland
C++ 3.1 and Application Frameworks and uses the MCI interface of Windows 
3.1.    Nearly all of the documentation for CDMaster is provided via the online 
help system.

General Help is accessed by pressing the F1 key.    Context sensitive 
help is accessed by pressing Shift-F1.    I hope you like CDMaster enough to 
share your observations and suggestions with me, and if I'm lucky, you will 
register CDMaster.



Overview of CDMaster
CDMaster is intended to be the only application you need as far as 

controlling a CD-ROM drive attached to your PC in audio mode.    There are 
various hardware and software requirements to be able to use CDMaster.    If 
you are having trouble getting CDMaster to work with your machine, please 
consult the applicable help topics and the Questions and Answers topic in 
this documentation.

CDMaster allows you to program the CD-ROM player that is attached to
your PC the way you would your audio CD player.    You can play CD's in two 
modes, Entire CD mode or PlayList mode.    For more information on these 
modes, please consult the Using CDMaster topic and the Modes of Operation 
topic. 

When CDMaster first loads, it interrogates your hardware in this order.

1. Dou you have a CD-ROM drive attached?
2. If so, is media (a CD) in the drive?
3. If there is a CD in the drive?

a. How many tracks on the CD?
b. How long is each track?
c. Is a CD currently playing?

If CDMaster fails to identify the CD drive or the CD that is loaded, it 
informs you by way of a message box and certain functions are disabled.    
Otherwise, CDMaster is ready for either PlayList programming or direct entry 
of a desired track.    By default, just pressing Play will start play at track one 
in Entire CD mode or the first track in a PlayList in PlayList mode. 



About CDMaster
CDMaster is a copyrighted work of software and as such is protected by

all applicable laws.    Please see the License and Warranty section of this 
document.
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CDMaster is the result of many hours of hard work and a few late 
nights.    I hope you, the user, are pleased enough with my work to register 
this program.    The registration fee is a nominal one.    By registering this 
program you will receive free techinical support and a free copy of the next 
version of the program.



Using CDMaster
Since CDMaster behaves similar to a real CD player, CDMaster is, for 

the most part, pretty simple to use.    If there is no CD-ROM drive attached to 
your machine or if no CD is present in the drive, CDMaster disables the 
pushbuttons associated with the operation of the CD-ROM drive.    Otherwise 
the usage of CDMaster should be straight forward.    It is recommended 
however that you should read the topic regarding PlayLists.    If you have any 
difficulty with the basic operation pushbuttons, there are sections in this 
documentation detailing their use.

See also:
Modes of Operation
PlayLists Described



Modes of Operation
There are two modes of operation for CDMaster.    Normal or Entire CD 

mode and PlayList mode.

See also:
Entire CD mode
PlayList mode



Play Lists Described
Just as you can program most audio CD players to play selected tracks 

from a CD, you can do this with CDMaster.    With CDMaster you can also 
Save new PlayLists and Load existing PlayLists.

A PlayList contains the tracks you wish to play and the order in which 
to play them.    The order is represented by the ordinal position in the list, 
that is they are played in the order the occur in the list.

See also:
Modes of Operation



Saving PlayLists
You can save a PlayList for later retrieval.    This is done by selecting 

File|Save PlayList off the menu.

PlayLists are saved and indexed by name, so no two PlayLists can have
exactly the same name.    When saving a PlayList, if the name is identical to 
an existing PlayList, the information related to that PlayList is replaced by the
current information.    Otherwise, the PlayList is saved under the name 
provided.

When saving a PlayList, the tracks contained in the current PlayList are 
displayed in the listbox below the name.



Loading PlayLists 
You can load a previously saved PlayList by selecting File|Load PlayList 

off the menu.    When you load a PlayList, CDMaster checks to see if the CD in
the drive is the same as the one that the PlayList was created for.

If it isn't, CDMaster will ask you if your sure you want to load this 
PlayList.    The reason for this is that CDMaster plays tracks from their ordinal 
position on the CD.    Using the incorrect PlayList for a CD is not 
reccommended.

Remember:    CDMaster saves the total number of tracks on a CD with the 
PlayList.    Therefore, if you load an incorrect PlayList, modify it for
that CD, and then save it, you may recieve an error when you try
to load it for the correct CD.



Contacting the Author
I am always interested in hearing input from users of my software, both

good and bad.    Whether you have a bug report, you don't like something 
about the user interface or whatever, please drop me a line.    I may be 
contacted either via email at:

Compuserve:    75600,631
or at:

Thomas L. Thornbury
Semaphore Software
1309 Melanie Street
Easton, PA    18042



CDMaster User License & Warranty
Semaphore Software is a trade name used by Thomas L. Thornbury 

and the two may be used interchangeably.    Therefore, all copyrights, 
distribution rights, and other rights or liabilities under this agreement are 
held by Thomas L. Thornbury.

This is the CDMaster License Agreement and describes the warranty 
given by Semaphore Software.    Please read the agreement and sign and 
date the registration form.    Failure to register this software renders any and 
all warranties, express or implied, pertaining to the product and it's use, null 
and void.    This is sole agreement between you and Semaphore Software 
governing the use of CDMaster.

License
This agreement gives you a non-exclusive right to use this program.    

This program may only be used on a single computer.    You may physically 
transfer the program from one computer to another provided that the 
program is only used on one computer at a time.    You may not distribute this
program via any medium, including but not limited to, Local or Wide Area 
Networks; data communication lines; floppy or hard disks; or any other data 
transfer medium for the purposes of profit or personal/commercial gain 
without first obtaining these rights from Semaphore Software.    You may 
however, distribute this software in its original archive to other individuals or 
organizations via any medium you wish provided no fee is charged for it's 
duplication or distribution.    Online usage charges such as usage charges 
charged by Compuserve and similar networks are not considered distribution
fees for the purposes of this agreement.

Copyright
CDMaster is the valuable proprietary property of Semaphore Software 

and is protected by Title 17 of the United States Code otherwise known as 
Copyright Act of 1976 and by laws of most foreign countries.    Thomas L. 
Thornbury owns all rights to CDMaster including the Copyright.    This 
agreement does not convey ownership to CDMaster to you, but is only a right
to use a copy of the product in accordance with this agreement.    Copyright 
infringement under the U.S. Copyright Act carries a fine of up to $25,000 and
imprisionment of up to one year (17 USC 506).

Limited Warranty
If you obtained this program directly from Semaphore Software on 

magnetic media, Semaphore Software warrants that:



(a) The magnetic media on which the program is recorded is not 
defective;

(b) The program is properly recorded on the magnetic media;

(c) The programs functions as described in the attached 
documentation and online help system.

Semaphore Software specifically excludes all other express and implied
warranties, including warranties of merchantability and fitness for a 
particular purpose, and limits the end users remedy to replacement of the 
defective media.

If you obtained this software from an online service such as 
Compuserve, Semaphore Software warrants that:

(a) If the archive is a copy of the archive supplied to online service, the
executable programs are extractable from the supplied archive;

(b) The programs functions as described in the attached 
documentation and online help system.

Semaphore Software specifically excludes all other express and implied
warranties, including warranties of merchantability and fitness for a 
particular purpose.    The sole remedy to the end user is that Semaphore 
Software will re-introduce the software to the Compuserve Information 
Service regardless of what Information Service the software was obtained 
from.

Miscellaneous
Any provision or provisions of this agreement which is or are proved to 

be invalid, void, or illegal shall in no way offset, impair, or otherwise 
invalidate any other provision.    It is the intention of the parties that this 
agreement be governed by the laws of the state of Pennsylvania.    Any 
action or proceeding based on this agreement arising out of its performance 
shall be brought in a Federal or State Court in Pennsylvania and in no other 
jurisdiction.

Copyright © 1993 by Thomas L. Thornbury.    All rights reserved.
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Product Registration
By registering CDMaster, you not only clear your conscience and 

become a licensed user, you will also recieve notice of updates to CDMaster 
and announcements of new products.    You will also receive a disk 
automatically when the next version of CDMaster becomes available.

Registration costs only $15.00.    To register, select the following text 
Registration Form, and then select File|Print Topic from the Help System 
menu.



Copyright/Trademark Acknowlegements
Microsoft is a registered trademark of Microsoft Corporation.

Windows is a trademark of Microsoft Corporation.

Compuserve is a registered trademark of Compuserve, Incorporated.

Borland C++ is a trademark of Borland International, Incorporated.



Questions And Answers
Q. When I exit CDMaster while a CD is playing, it sounds like my CD is 

skipping. Why?    Answer

Q. I have a play list loaded and I just changed CD's.    CDMaster is telling me 
the current PlayList conflicts with my new CD.    Why?    Answer

Q. I just brought up CDMaster and it is acting as though there is no CD in the
drive but it didn't give me an error.    What's the problem? Answer



Registration Form
TO: Thomas Thornbury

Semaphore Software
1309 Melanie Street
Easton, PA    18042

Enclosed is my registration form and applicable registration fee.    I 
understand that by registering CDMaster I will receive the next version of 
CDMaster free of charge and that I will receive announcements of future 
versions and products.

Name____________________________________________________

Address_________________________________________________

City___________________________ State _____ Zip ________

What version of Windows are you using? ________

Make and Model of CD-ROM Drive _________________________

Number of CD's owned. ___ Audio ___ Data CD's ___

Where did you acquire CDMaster ?

        Compuserve [ ]      Genie [ ]        America Online [ ]

        BIX [ ]      Prodigy [ ]        America Online [ ]

        Internet [ ]        Other [ ]

Forum/Newsgroup or BBS Name ____________________________

________________________________________________________

Magazines you read regularly. __________________________

________________________________________________________

Suggestions/Comments ___________________________________

________________________________________________________

________________________________________________________



MSCDEX.EXE 

MSCDEX.EXE is the Microsoft CD Extensions driver.    CDMaster has only been
tested with version 2.21 or greater.    If you do not have the latest version, 
you can usually download this file from an online service service such as 
Compuserve or obtain it directly from Microsoft.



MCICDA.DRV 

MCICDA.DRV is the Multimedia Communications Interface CD Audio driver.    
This file is installed through the Control Panel in Microsoft Windows.    Please 
consult the documentation in Windows on how to install this file.



Selecting PlayList mode
The PlayList mode of CDMaster is invoked by setting the radio button 
corresponding to PlayList Mode to on.    This act will automatically set the 
Entire CD mode radio button to off since the two are mutually exclusive.



Selecting Entire CD mode 

The Entire CD mode of CDMaster is invoked by setting the radio button 
corresponding to Entire CD to on.    This act will automatically set the PlayList 
mode radio button to off since the two are mutually exclusive.



Selecting Play to End
CDMaster needs to know what to do with a playing CD if you exit the 
application while a CD is playing.    Upon exit, CDMaster sends his last dying 
message to your CD player.    By default, CDMaster will finish playing the 
current track.    If you want CDMaster to tell the CD player to finish playing 
the entire CD, select this option.
note:    This does not apply to PlayLists.    If this option is selected and a PlayList is active, 
CDMaster acts as if it was in Entire CD mode and plays the entire CD.



Ordinal
Ordinal means in order, like 1,2,3 or first, second, third.



A. During operation, CDMaster plays each track one by one.    If you exit 
CDMaster and Play To End is selected in Options, CDMaster needs to save
the current position and reissue the play command to your CD-ROM drive
instructing it to continue play from the saved position and then all 
remaining tracks on the CD.    If Play To End is not selected, the CD-ROM 
drive plays to the end of the currently playing track.



A. CDMaster has a pretty good idea of whether the currently loaded PlayList 
corresponds to the currently loaded CD.    If they don't, CDMaster sees 
this as a conflict and generates a message to that effect.    Since 
CDMaster plays from ordinal positions, and since CDMaster won't let you 
program a PlayList for a CD that's not loaded, this check isn't really 
required for PlayList integrity.    This check is performed so that you are 
aware that you are loading a PlayList for a unloaded CD.    Using the 
incorrect PlayList for a CD can cause unpredictable results.



A. It's possible the problem could be hardware related.    However, if you've 
loaded and used CDMaster before and now all of a sudden CDMaster isn't
sensing the status of your CD-ROM drive or the number of tracks, you 
probably have accidentally turned on No Status Checks on the Options 
menu.    If you turn this off, CDMaster should work fine.



File Menu
The following menu options can be found off the File Menu.

File|Load PlayList
File|Save PlayList
File|Exit



File|Load PlayList
You can load an existing PlayList using this menu selection.



File|Save PlayList
You can save a defined PlayList using this menu selection.



File|Exit
To exit CDMaster, either double click on the system menu box in the 

upper left hand corner or select Exit CDMaster off the menu.
note: By default, upon exiting CDMaster, the CD-ROM will stop playing after the current 

track.    To change this, select the Play To End off the Options menu.



Options
The following menu options can be found off the Options Menu.

Options|No Status Checks
Options|Minimize Status Checks
Options|Play To End



Options|No Status Checks
This option tells CDMaster to not poll the CD-ROM drive at all for status

information.    This useful if you want to load CDMaster in your startup, but 
only use it to start/stop/pause the CD-ROM drive.
note: Since this option disables status checks and since this option is saved in 

CDMASTER.INI, it can appear that CDMaster is not functioning correctly.    Please see 
the Questions and Answers section.



Options|Minimize Status Checks
This option tells CDMaster to only poll for status when CDMaster is 

windowed.    If you select this option, when CDMaster is iconized, no status 
checks are performed.    This is beneficial if servicing these requests puts too 
much stress on your system.



Options|Play to End
Normally, each time a track finishes playing, the CD-ROM drive sends a

message to CDMaster to tell it it is done.    CDMaster then either plays the 
next track in the PlayList if in PlayList mode or the next track on the CD if in 
Entire CD mode.

A side effect of this approach is that if you exit the application, since 
CDMaster isn't running he doesn't know what to do when the track finishes.    
By selecting this option, CDMaster sends a final command to the CD-ROM 
drive instructing it to play the rest of the CD.
note:    This does not apply to PlayLists.    If this option is selected and a PlayList is active, 

CDMaster acts as if it was in Entire CD mode and plays the entire CD.



Play
To play a loaded CD, just press the Play button.    In Entire CD mode, 

play will begin at the first track on the CD.    In PlayList mode play will begin 
at the first track in the PlayList.



Stop
To stop CDMaster, just press the Stop button.    Upon pressing the Stop 

button, play is stopped and certain buttons that don't make sense in this 
state, like Stop and Pause, are grayed out.



Pause
To pause CDMaster while playing a track, press the Pause button.    

CDMaster saves the current position and pauses the CD.



>> (Next Track)
To go to the next track on the CD, press this button.    Pressing this 

button in Entire CD takes you forward 1 track on the CD.    Pressing this 
button in PlayList Mode takes you forward 1 track in the PlayList.



<< (Previous track)
To go to the previous track on the CD, press this button.    Pressing this 

button in Entire CD takes you back 1 track on the CD.    Pressing this button 
in PlayList Mode takes you back 1 track in the PlayList.



> 10s (Next 10 seconds)
To go forward 10 seconds in the currently playing track, press this 

button.    This button is independent of mode, it moves you within the track 
only.



< 10s (Previous 10 seconds)
To go backward 10 seconds in the currently playing track, press this 

button.    This button is independent of mode, it moves you within the track 
only.



0 thru 9
To direct enter a track for playing, use the number pushbuttons or type

the number of the track you want using the digits 0 thru 9.    When entering a
track directly, CDMaster treats the first character entered as the most 
significant.

If the pushbutton is grayed out, it is because there are less than that 
number of tracks on the CD.
Example:    To enter track 12, press 1 and then 2.



Restart Track Entry
To cancel the direct entry of a track, press this button.    When entering 

a track directly, CDMaster treats the first character entered as the most 
significant.
Example:    To enter track 12, press 1 and then 2.



PlayList Programming
To program a PlayList for the currently loaded CD, press this button.    

You will be presented by two list boxes.    The left listbox contains tracks that 
are in the current PlayList.    The right listbox contains a list of all tracks on 
this CD.

See also:
Add to List
Remove from List



Add to PlayList
Select a track from the right listbox and optionally provide a name for 

the track and press this button.    A occurrence of this track will be added to 
the PlayList (left listbox).



Remove from List
Select the track you wish to remove from the left listbox and press this 

button.    The track will be removed from the PlayList.



Entire CD Mode
Select the Entire CD mode radio button.

In this mode, all tracks on the CD will be played.    The default is to start
from track one, however you may also direct enter the desired track.    By 
then pressing the Play pushbutton, play will begin at the selected track.



PlayList Mode
Select the PlayList mode radio button.

In this mode, the tracks specified in the PlayList will be played 
according to the options set in the Play Options group to the right.



Software Requirements
CDMaster requires that you be running Microsoft Windows 3.1.    While 

CDMaster may run under Windows 3.0 with Multimedia Extensions, it is not 
recommended.

CDMaster also requires the latest versions of the following files/drivers 
to be loaded.

MSCDEX.EXE Ver (2.21+)
MCICDA.DRV (3.10+)



Hardware Requirements
CDMaster requires that you have a CD-ROM device attached to your 

machine that is audio capable.    Most CD-ROM drives available today are 
audio capable.



Keys
The following is a list of keys that are valid in CDMaster.

F1 General Help/Help Index
Shift-F1 Context Sensitive Help
Alt-S Save PlayList
Alt-L Load PlayList
Alt-X Exit CDMaster
Alt-N No Status Checks
Alt-Z Minimize Status Checks
Alt-E Play to End
Alt-P Play
Alt-O Stop
Alt-< Previous Track
Alt-> Next Track
Esc Cancel Direct Track Entry
0 thru 9 Same as Numeric Pushbuttons



F1

F1 is the general help key.    It will bring up the Windows Help Facility 
and position you at the index.



Shift-F1

Shift-F1 is the context sensitive help key.    If the focus is on a control or
key that has context sensitive help, this key will take you directly to the
help for that key.




